WD-68 UNIT 1 Basic Skills

Concepts Review

True/False Questions

Each of the following statements is either true or false. Indicate your
choice by circling T or F.

Underline styles are only available in the Font dialog box.
To remove character formatting, press [Ctrl]+(Delete].

The Home tab on the Ribbon is used to insert a drop cap.
Times New Roman is an example of a sans serif font.

You can use [F4) to repeat text or to repeat character formatting.
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After clicking the Format Painter button, you can press to restore
the normal pointer.
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You can use the Font dialog box to change character spacing.

T F 8. The superscript text effect places text below the baseline.

Short Answer Questions

Write the correct answer in the space provided.

1.  Which Ribbon tab contains a command to highlight text?

2.  Which dialog box do you use to choose bold-italic style?

3. What unit of measurement is used to measure fonts?

4. What keyboard shortcut increases the font size of selected text?

5. What character effect places a horizontal line through text?

6. Which command do you use to copy character formatting?
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7. What keyboard shortcut do you use to change the case of selected text?

8. What character spacing setting inserts additional space between
characters?

Critical Thinking

Answer these questions on a separate page. There are no right or wrong
answers. Support your answers with examples from your own experience,
if possible.

1. Select three examples of effective character formatting in magazine
advertisements, articles, or other publications. Describe why you think
the character formatting was particularly effective for each example.

2. Using a large font size, key Fonts & styles 10 times on 10 separate lines.
(You can use the Repeat Typing command.) Apply a different font to
each line. Describe the differences you see among the fonts.

Skills Review

Exercise 2-16

Apply basic character formatting. Change font and font size.

1. Open the file Candy - 1. Click the Show/Hide § button | 7 | if necessary.

2. At the top of the document, press [Enter]. Move to the paragraph mark,
and key Fine Chocolates.

3. Change the font for the entire document by following these steps:
a. Select the entire document by pressing (Ctri)+(A).

b. Select the Home tab. Open the Font drop-down list by clicking the
down arrow.

c. Locate and click Arial.

4. Change the first line heading to 16-point bold by following these steps:

a. Select the text by moving the pointer to the left of the text. When the
arrow points to the text, click the left mouse button.

b. Choose 16 from the Font Size drop-down list on the Ribbon.
c. Click the Bold button B on the Ribbon.
5. Apply italic formatting to noncontiguous text by following these steps:

a. Move to the end of the document, and press [Enter].
b. Key Call our toll-free number: 800-555-2025.

c. Select the sentence you just keyed.
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d. Press and hold [Ctr), and select the text “Campbell’s Confections” in
the first line of the previous paragraph.

e. Click the Ttalic button [.I].

Key new bold text by following these steps:

a. Move to the end of the document, and place the insertion point to the
immediate left of the period.

b. Click the Italic button | I | to turn off italic.

c. Click the Bold button B to turn on bold. Press the (Spacebar), and key
or visit our Web site at www.campbellsconfections.biz.

d. Turn off bold.
Save the document as [your initials]2-16 in your Lesson 2 folder.

Submit and close the document.

Exercise 2-17

Apply formatting options using the Font dialog box and using repeat
character formatting.

1.
2.

Open the file Cocoa Beans.
Apply character formatting to the first line. Use the Font dialog box, and
follow these steps:

a. Select the first line. Click the selected text with the right mouse
button, and choose Font from the shortcut menu.

b. Click the Font tab, if it is not already displayed. For font, font style,
and font size, choose Arial, Bold, and 14 points.

c. Apply the effect Small caps by clicking the check box.
d. View your options in the Preview box, and click OK.

Apply and repeat character formatting by following these steps:

a. Select the text “chocolate-covered cocoa beans” in the second line,
and press [Cti]+ (D) to open the Font dialog box.

b. Choose the font style Bold Italic.

c. Open the Font color drop-down list, and choose Blue. Click to select
Small Caps in the Effects section. Click OK.

d. Select the text “chocolate-covered cocoa beans” in the fourth line, and
press (F4). Repeat the formatting for each occurrence of “chocolate-
covered cocoa beans:”

Apply the Superscript effect from the Font dialog box by following these
steps:

a. Position the insertion point after the period following “chocolate-
covered beans” in the second sentence.

b. Key an asterisk (*) after the period. Select the asterisk.
c. Locate and click the Font Dialog Box Launcher [ on the Ribbon.
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d. Click the Superscript check box.
e. Click OK. Notice the superscript effect.

f. Click the Show/Hide { button | 1 | to hide the text and formatting
characters.

Move to the end of the document, press (Enter), and key *Cacao bean is
the original spelling, but cocoa bean is the popular spelling.

Select the asterisk, and apply the superscript format by clicking the
Superscript button [x*|in the Font group on the Ribbon.

Save the document as [your initials]2-17 in your Lesson 2 folder.

Submit your work.

Exercise 2-18

Copy character formatting and change case.

1.
2.

Open the file WV Stores.

Change the first line to read Campbell’'s Confections—West Virginia
Retail Stores.

At the end of the first line, press (Enter), and key premiere chocolates and
specialty items.

Select the first two lines of text, and format them 14-point bold.

Use a keyboard shortcut to change the case of the first line to all
uppercase by following these steps:

a. Select the first line of text.

b. Press (shift)+(F3).

Change the case of the second line using the Change Case command by
following these steps:

a. Select the second line of text.

b. Click the Change Case button [Aa|on the Ribbon.

c. Click Capitalize Each Word.

Use the Font dialog box to format the first store name, “Campbell’s
Confections,” as bold-italic small caps.

Copy the character formatting to the other store names by following
these steps:

a. With the formatted text selected, double-click the Format Painter
button [#].
b. Drag the pointer over the next store name, “Campbell’s Confections.”

c. Continue copying the formatting to the other store names. Use the
scroll bar as needed. When you finish copying, click the Format
Painter button | #| to restore the normal pointer.
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9. In the second line, change “And” to lowercase.
10. Save the document as [your initials]2-18 in your Lesson 2 folder.

11. Submit your work, and close the document.

Exercise 2-19
Highlight text, apply text effects, and create a dropped capital letter.

1. Start a new document by keying the text shown in Figure 2-16. Use
12-point Arial type.

ng“3246 Bittersweet chocolate also known as semi-sweet chocolate

is the darkest eating chocolate. It also has the highest
percentage of chocolate liquor (unsweetened chocolate).
Bittersweet chocolate usually consists of 50 percent
chocolate liquor, and semi-sweet chocolate typically
consists of 35 to 45 percent chocolate liquor. Both have
a rich, smooth taste and are used for chocolate chips and
baking.

2. Highlight part of the document by following these steps:

a. Click the down arrow next to the Highlight button [, and click the
yellow highlight.

b. Use the highlight pointer to select the text “50 percent.”
c. Press to restore the normal pointer.

3. Create a dropped capital letter by following these steps:
a. Position the insertion point at the beginning of the document.
b. Click the Insert tab, and click Drop Cap.
c. Click Dropped.

4. Remove the highlight by following these steps:
a. Select the highlighted text “50 percent.”

b. Click the Home tab. Click the down arrow next to the Highlight
button and choose No Color.

“sn

5. Format the first two words after the drop cap (beginning with “i”) as
14-point bold. Do not deselect the text.
6. Add text effects to the selected text by following these steps:

a. Click the Text Effects button |2, and click Outline. Click More
Outline Colors, and click the Standard tab in the Colors dialog box.

b. Click a brown color, and click OK.

7. Save the document as [your initials]2-19 in your Lesson 2 folder.

8. Submit and close the document.
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Apply and copy character formatting. Change font size.
1.
2.

10.
11.
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Open the file Milk Chocolate.

Format the first line (“Milk Chocolate”) to 14 points, and change the
font to Impact. (If Impact is not available, choose another bold-looking
font from the Font drop-down list.)

. Select the text “10 percent” and format the text as italic. Change the font

color to blue.

Use the Format Painter button |# to apply the formatting of
“10 percent” to “12 percent.”

. Apply small caps effects to the first line, and add a text effect. Change

the character spacing to expanded 1 pt to improve readability.

Select “Milk chocolate” at the beginning of the descriptive paragraph
under the heading. Use the Ribbon to bold the text and apply italic
formatting.

Position the insertion point before the word “best.” Press [F4) to repeat
the last selected character formatting (italic), key very, and press

(Spacsbar)

Press [Ctr)+(End] to go to the end of the document. Press and key
Enjoy!

Select the last line, and change the text to 12-point Times New Roman.
Add red double underlining to the line, except the exclamation point.

Save the document as [your initials]2-20 in your Lesson 2 folder.

Submit your work, and close the document.
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Exercise 2-21

Apply and copy character formatting. Change font size, case, and
character spacing.

1. Start a new document by keying the text shown in Figure 2-17,
including the corrections. Use 12-point Arial type. Click the Change
Styles button [}, and click Style Set. Choose Word 2010.

Figure 2:17 A chocolate glossary is helpful to understand the

differences and similarities among chocolate ingredients.

(unsweetened chocolate) (nibs)
Chocolate liquorpis the ground up center,of the roasted

and
cocoa bean. It is the basic ingredient of chocolatepcocoa
products. Cocao butter is the vegetable fat extracted

during the refining process. It—is—the base of white

chocolate. Cocgd powder is made by removing most of the
cocoa butter from the chocolate liquor. The remaining
solids are ground to produce unsweetened cocoa powder.
There are two types of cocoa powder: Dutch-processed

and natural unsweetened cocoa powder.

2. In the first line, change the case of the text “chocolate glossary” to all
capitals.

3. Copy or repeat the all-capitals formatting to the following words in the
paragraph: “Chocolate liquor,” “Cocoa butter,” and “Cocoa powder.”

4. Create a new paragraph for each term, beginning with “CHOCOLATE
LIQUOR.” (You should have four paragraphs in the document.)

5. At the beginning of the document, insert one blank line (press once).
Key the title Guide to Chocolate Terminology at the paragraph mark.

6. Format the text you just keyed to bold, dark blue, small caps, and
16-point type.

7. Format the text “nibs” as italic. Repeat the italic formatting to “Dutch-
processed” and “natural unsweetened cocoa powder.”

8. Select all the paragraphs below the heading, and change the font size to
11 points.




Figure 2-18

>

You need select only one, or a portion of,
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9. Use the key to select noncontiguous text, and select “CHOCOLATE
GLOSSARY,” “CHOCOLATE LIQUOR,” “COCOA BUTTER,” AND
“COCOA POWDER.” Change the font color to light blue.

10. Save the document named [your initials]2-21 in your Lesson 2 folder.

11. Submit your work, and close the document.

Exercise 2-22

Apply and copy character formatting, highlight text, and create a dropped
capital letter.

1. Open the file Favors - 2.

2. Key the text shown in Figure 2-18 at the end of the document. The text
should be the last sentence of the last paragraph.

For more information, call our toll-free number 800-555-2025
or visit our Web site www.campbellsconfections.biz.

3. Format the “C” of “Campbell’s” in the first paragraph as a dropped
capital letter.

4. Highlight the second paragraph (which begins “Our chocolate”) in
yellow.

5. Format the list of items from “wedding bells” through “other assorted
shapes” as 11-point Arial italic small caps.

6. Copy the formatting to the second list (from “solid milk chocolate” to
“dark chocolate with mint filling”).

7. Split the last paragraph so “For more information” starts a new
paragraph.

8. Copy the formatting from one of the lists to the new last paragraph.

9. Format the phone number in the last paragraph as

REVIEW red, bold, and a dotted underline.

10. Remove the highlight from the second paragraph.

the formatted words, click the Format 11. Select the first line of the document, format the text

Painter button, and then select the new

with 24 points, and apply a text effects option from the
gallery. Experiment with the options available for the
text effect.

paragraph.

12. Save the document as [your initials]2-22 in your Lesson 2 folder.

13. Submit your work, and close the document.
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Exercise 2-23 ® Challenge Yourself

Apply character formatting, change case, and apply text effects.

1. Open the file Club.

2. Locate “Chocolate Club” in the first sentence of the first paragraph.
Select the text, and apply bold, small caps format.

3. Copy the bold and small caps format to all occurrences of “Chocolate
Club” in the document.

4. Select “Campbell’s Confections” in the first paragraph. Format the
selected text as blue, bold, 12 points, and small caps. Copy the format to
all occurrences of “Campbell’s Confections.”

5. Move to the beginning of the document, and key Chocolate Club. Press
(Enter). Select the title, and change the font size to 24 points. Use the Text
Effects button to format the title attractively. Experiment with the text
effects options.

6. Select “$36.” Use the Ribbon to format the text with a blue, dotted
underline.

7. Copy the format applied to “$36” to “$360.”
8. Save the document as [your initials]2-23 in your Lesson 2 folder.

9. Submit your work, and close the document.

In these exercises you work on your own, as you would in a real-life
business environment. Use the skills you’ve learned to accomplish the
task—and be creative.

Exercise 2-24

Create a list of three companies in the United States that manufacture
chocolate. Include the companies’ addresses, a brief history of each
company, and a description of the types of chocolate they manufacture.
Apply interesting text effects to the first company name. Copy and repeat
the formatting to the other companies in the list. Apply character format
to headings and text you want to emphasize. Save the document as
[your initials]2-24 and submit it.
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Exercise 2-25

Use the Internet to research the format to follow when creating an itinerary.
Create an itinerary for a trip to visit Hershey, Pennsylvania. (Be imaginative!
This could be a real trip or a fantasy trip.) To make the itinerary interesting,
use several of the character formatting features you learned in this lesson.
Remember, though, the itinerary must be readable. Save the document as
[your initials]2-25 and submit it.

Exercise 2-26

Log onto the Internet, and locate two different sources for guidelines on
type design. Create a document describing the guidelines one should
follow to create a document that looks professional and follows the
recommended procedures for character formatting. Save the document
as [your initials]2-26 and submit it.



